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What should | The first thing you should do is make backup copies of
do first? all your WetPaint disks. They are not copy-protected.

Instructions for using the Finder to copy disks and files
can be found in your Macintosh owner's manual.

And next? It would be helpful to read pages 3 - 6 of this manual if
you are not familiar with paint programs (like FullPaint
or MacPaint). The few minutes you take to read them
may actually save you time in the long run!
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What is not '
included on
the disks

The WetPaint disks are data disks. That 1s, there 1s no
System or Finder on any of them. That means you will
have to start up the Macintosh with one of your own

System disks before you can do anything with WetPaint.
(Complete instructions for Accessing and Using
WetPaint files begin on the next page).

What is included
on the disks

Art RoundUp

Pattern Mover

San Quentin

WetPaint is primarily a collection of clip-art stored
in files created by Ann Arbor Softworks’ FullPaint

application. WetPaint files may also be read by other
“paint” style programs (MacPaint, MacBillBoard, and
SuperPaint are some examples). (See next page for
instructions for Accessing & Using WetPaint files ).

There are also some utilities from Dubl-Click:

Art RoundUp is a desk accessory that allows you to
open/view and copy from WetPaint files without the use
of a painting program. It can be used in many Macintosh
applications. (See page 11 for instructions).

Pattern Mover 1S a desk accessory that lets you copy
and/or edit pattern pallettes. These are the same kind of
pallettes that appear in applications like FullPaint,

MacPaint, MacBillBoard and SuperPaint (complete
instructions start on page 17).

WetPaint Volume Two has one font:

This is a 72 point font which can be used along with the
Plate Frames file to create special “vanity” license plate
messages. Since this font is quite large, we have typed all
of the characters from San Quentin 72 into a WetPaint
file called Plate Letters, allowing easy access 1n limited
memory situations. To use the San Quentin font, you

must first install it using the Font/DA Mover (complete
instructions start on page 7).

About the
Directories

Starting on page 21 are directories of WetPaint volumes
one and two. Directory of Disk Contents lists all files
grouped by volume and disk. Directory of Volume

Contents lists all filenames in alphabetic order (the disk

name is next to each filename). Directory of Images
contains a print-out of each file for easy reference.
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Accessing and Using WetPaint files

About WetPaint
documents

=

WetPaint images are stored in “paint” documents that
were created using an application called FullPaint from
Ann Arbor Softworks. Consult the Directory of
Images (starting on page 23) to geta quick view of the
contents of each file. In addition to the images stored
within the WetPaint files, each file contains a unique
pallette of 36 patterns (plus black and white). See page
17 for more about patterns and the Pattern Mover DA.

Accessing WetPaint
images

Double-Click the
icon from the
Finder...

Pull-down Open from
the File menu...

Use the Art Roundup
desk accessory...

There are three different ways to open and access a
WetPaint file:

If you own FullPaint, you may open one or more
WetPaint documents by selecting the file(s)' icon(s) from
the Finder. This will simultaneously open the FullPaint
application.

You may also open WetPaint files if you own MgngjEt,
SuperPaint, MacBiliBoard or another “paint program
that manipulates files stored in the MacPaint format
(techies: that's any file with a file type of PNT_G). Start by
double-clicking the “paint program” to open it. After the
program is running, you may open the WetPaint
document by pulling down Open from the File menu,
and then selecting the file you wish to open. (Note that
some programs like MacPaint and MacBillBoard allow
only one open file at a ime, s0 you may have to close the
work window before opening a new file).

You may also open WetPaint files using our Art
Roundup desk accessory (on disk A of each We tPaint
volume). Art Roundup allows you to copy an 1mage
directly from the WetPaint file without leaving an
application to do so. You may also invert, hon:zongally
and vertically flip a copy the image befo_re_ putting it on
the clipboard— without affecting the original image
stored in the file. Note that if you require further
modification of any WetPaint image, we suggest that you
use one of the “paint programs.” (For complete

instructions on Art Roundup. see page 11).
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About Large
Images:

You will find that some of the WetPaint images are
larger than the work window in MacPaint. There are

several techniques to transfer these images to your own
documents:

Using MacPaint

or MacBillBoard...

the lasso tool

If you are using MacPaint or MacBillBoard and are on a
Macintosh with less than 512K of random access

memory, you will need to copy a large image in sections;

one section at a time. Here's how:

Open a WetPaint file, select and Copy a section of the
image you want. Close the WetPaint file and open your

own file. Paste this section of the image into your file.
Close your file.

Now repeat the instructions in the paragraph above—
except copy a different section of the image. If you use

the lasso tool (shown in margin) to do your selecting, and

always select part of what you previously selected, it is
easy to allign the new section with the old section when

you do your pasting. Repeat all of this until the entire
image has been copied.

Using FullPaint,

SuperPaint or
Art Roundup...

&R,

the marquee tool

If you have any of these programs, and at least 512K of
random access memory, then you may copy a large
image as a single section.

With these “second generation” paint programs, it is

possible to copy more of the image than shows on screen.

Using SuperPaint or Art Roundup, the marquee tool
(shown 1n margin) automatically scrolls as you move the

crosshairs (the mouse's cursor) outside the content
portion of the window.

FullPaint works in a similar manner as described above,

except you will need to hold down the option key before
you start the marquee selection.

By the way, 1n FullPaint or SuperPaint: holding down
the command key down while selecting will tighten the
marquee down to the smallest size that will surround the

entire selected image—as soon as you let go of the mouse

button.
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WetPaint image
Printing Tips

WetPaint images can be printed on both the ImageWriter
and LaserWriter printers.

=il
O

Within Word
processors...

On the ImageWriter (driver version 2.3 or newer):

An image pasted into a word processing document will
appear slightly stretched (taller) on the printer unless
you select the Tall Adjusted option when you do the
Page Setup (usually located on the file menu).

1 ___
=

Smoothing...

300 dpi
(dots per inch)...

Scaling...

On the LaserWriter (driver version 3.1 er newer):

If you want a WetPaint picture to print exactly the way it
appears on your screen (square pixels and all), leave the
smoothing checkbox unchecked in the dialog box that
appears when you do the Page Setup (usually located on
the file menu). You may not want to smooth extremely
detailed images (that contain lots of gray patterns) as the
smoothing process will require a great deal of time, and
the image will probably not come out as crisp as it would
with smoothing turned off.

300 dpi is fast becoming an overused buzzword to
LaserWriter owners. The fact of the matter is that
everything printed on the LaserWriter is printed at 300
dots per inch. What really matters is what size each of
the screen's pixels gets printed on the LaserWriter. Read

on about Scaling...

The SuperPaint program from Silicon Beach Software
offers a feature called LaserBits. LaserBits works like
MacPaint's FatBits, but at a greater magnification.

To provide some perspective: a 1x 1" image e_ditefi in

I aserBits and printed at 100% on the Laserwriter 1s
roughly equivalent in resolution (on paper) to a standard
4 x 4" WetPaint image printed at 25% on the
LaserWriter. Both printed images look quite detailed—

you might even say startling.
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Now it isn't very practical to create all of your
documents at 400% size, just so that the images within
them look terrific! Happily, there 1s an easier way. The
idea is to scale just the specific image—not the entire
page. The image will look rather muddy on screen, but
great on paper. So, the 4 x 4" image printed at 25% 1s
exactly equivalent to the same image stretched 4 times
smaller on the screen, then printed at 100%. This

technique works great in programs like MacWrite,
FullWrite and PageMaker.

'E'l |
1 | =

From within

Paint Programs...

On either the ImageWriter or the LaserWriter:

Y ou smooth the image by using the Print Final
option. Print Draft will provide an unsmoothed
version of what you see on the screen. If you do not
enlarge or reduce the image at print time, it will print
completely unscaled and undistorted.
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' Font/DA Mover Application

Using Apple’s The Font/DA Mover (Font and Desk Accessory Mover)
Font/DA Mover is an application for copying fonts and desk accessories

to install fonts and among disks or removing them from disks. You will
desk accessories. need to use this application to install the San Quentin

font, and to install the Art RoundUp, and Pattern Mover
desk accessories.

The Font and # menus in applications always contain the
fonts and desk accessories that are in the current startup
disk's System file (a file in the System Folder). Other
fonts and desk accessories are contained in files that look

like this (in the Finder):

A font file A desk accessory file

Be sure to use the  Itis important to use the 3.2 (or newer) version of the

3.2 or newer Font/DA Mover if you are using a Macintosh Plus, or
version. are using the 128K ROMs (see page 10 for more

information as to why). The version # is in the menubar.

® Font
O Desk Rccessory

Athens 18
Cairo 18

Chicago 12 it
Courier 9
Courier 10

"M
H

Malibu 18 o
Malibu 24
Malibu 28

Courler 12 4568 bytes  |malibu 36

Courier 14 selected  |\Mmonterey 24
System : The Casual

on Hard Disk 20 | ion World Class Fon...

12726K free 39K free

pasavwiddsrgEna iR RFyEE [ L L L1J) 'II'I.II-H-I-III"“-I‘.II-I-I-I--!-IIIIII reddbpsnss @R AR EEER T ISR LT L L DL L) pdddiaasssnd-ipasEn uFBBEEE 1T 1T BELLL L L L et TP IS IS EL L L L UL L L L L L L b et

Malibu 14: 7he quick boown fox jumpe ovee L
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1. Select the

Font/DA Mover icon

and choose Open
from the File menu,

or just double-click
the icon.

2. Click either the
Font or the Desk
Accessory button,
depending on what
you want to add

or remove.

3. Use the Open
buttons to present
lists of any other

System, font or
desk accessory

files on any
inserted disk.

4. Open the file you
want to look at by
selecting its name
and then clicking
Open or by double-
clicking its name.

The Font/DA Mover is included on the "A" disk of this
collection. You can open it there or copy it to any other
disk. You can also open any font or desk accessory file

to open the Font/DA Mover automatically from the
Finder.

The list on the left includes all fonts or desk accessories
in the System file on the current startup disk, whether the
disk 1s in the internal or external disk drive. If you

open a font or desk accessory file instead of Font/DA
Mover, the list on the left shows the contents of that file.
Also, holding down the option key when the version

number first appears (in the upper left corner of menubar),

1s the same as clicking the Desk Accessory radio button.

If necessary, first click Close to close the file currently
displayed. Each Open button lets you control what's
displayed in its list. Both the file you're looking at and
the disk it's on are shown below each list.

Whenever you click an Open button, a dialog box
appears with a directory of folders and System, font, or

desk accessory files on the current disk or in the current

folder. (Holding down the option key while clicking the
Open button will display all file types).

As always, use the Eject or Drive buttons to look at files
on different disks.

You can look at and work with any existing System, font,
or desk accessory files, like the ones that came with your
WetPaint disks. If you'd like, you can create a

new file for your own collection fonts or desk

accessories by clicking New, naming the file, and
clicking Create.
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5. Select the fonts
or desk accessories
you want to copy

or remove.

6. Click Copy to
copy the selected

fonts or accessories

in the direction the
arrows point, or
click Remove to
remove them.

7. Click Quit.

Caution: Memory
Constraints.

You can select from either list. Click to select a single
font or accessory, hold down the Shift key while you
click additional single fonts or accessories, or drag to
select a group. Shift-click to deselect a selected file. The

number of bytes selected is displayed as well as the amount
of space available on the disk. Both the name of the current
file and the name of the disk it's on are displayed below each
list.

When a single font is selected, the name, size and a sample
of the font are shown at the bottom of the window; when
more than one font is selected or when a desk accessory is
selected, nothing is displayed. (Holding down the Option
key and clicking on a desk accessory displays some resource
information).

Clicking Copy copies the fonts or desk accessories to the
file displayed in the opposite list; clicking Remove

removes them from the file they're in. If a font or

accessory with the same name as one you selected already
exists in the opposite list, it will be replaced by the

selected font or accessory. If you remove all fonts or
accessories from a font or aceessory file, the file itself will
be gone the next time you click Open. (Have you backed up

your disks yet?). You can't remove certain fonts the System
needs.

Only fonts and desk accessories in the current startup disk's
file are available to applications you use ‘:Vlth that
disk. You're limited to 15 desk accessories in a single

System file.

In the Finder, you can drag any font or accessory files you

no longer need to the Trash, or copy or move these files
between disks.

The San Quentin font may occupy too much memory space
to work properly in situations where memory 1s at a

premium. Click on a single font name in Fon t/DA Mover to
display it's size in K. A small font would be in the 5K to
10K range. By contrast, a largest display font is around

32K. Also read the Warning on Art Roundup (on page
15)—before trying to use that desk accessory.
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m For MacPlus (or 128K ROM) owners! Using the Art Roundup desk accessory

Art Roundup is a desk accessory that allows you o read and copy directly from

Who floes this If you want to install fonts and are using a Macintosh Plus, your WetPaint (or any standard Macintosh “paint”) files from within many
warning affect? Enhanced 512K Macintosh, or a Mac that has been upgraded applications. You no longer need to copy all your pictures to scrapbook files in
with the 128K Macintosh ROMs, you should be reading this order to paste them into non-paint documents.

page. (We apologize for the technical talk that follows!) | | |
For instance, while writing a letter using FullWrite or MacWrite, you may wish to

The Problem: The part of the Mac's brain that remembers (ROM) how to paste a WetPaint illustration into your word Process@ng d_ocument. AILM%]UBM
locate fonts—The Font Manager— has been rewritten. lets you read the WetPaint file and copy the illustration directly from that file.
The Font Manager now expects to find some extra _ Y file of the same
information about font families that may not be installed The Art Roundup desk accessory 18 con}alrt?d ina Font/DA Mover 1l 0 : S
with your current fonts. (For the techies among us: Font name, located in the utilities folder on dlSk A” of each Mﬂ_@&.ﬁolum? ALl
Manager expects not only FONT resources, but Roundup must be installed using Apple's Mapphcaﬂon‘bet:ﬁe it can
accompanying FOND resources as well). be used (see the using Font/DA Mover section of this manual). After installation,

Art Roundup will appear in an application's % (Apple) menu.
If you install new fonts into your System file, and the old

fonts do not have this additional (FOND) information, there Start Art Roundup by pulling down its name from the § menu. The menus
is a good chance that the Font Mfmager) will not be able to associated with the current application will vanish, The Art Roundup menu will
locate some of your fonts. At best, you might not have appear along with its window:

access to all the installed fonts. At worse, this could

potentially crash programs.

The Solution: The 3.2 version of the Font/DA Mover (included on Disk N T R
'A’ of this collection) will install this extra (FOND) e e s s T T e e

information for you, whenever you Copy a font from one
file to another, including the System file.

Here's what to do (before installing any new fonts!). Use

Font/DA Mover to Copy all the fonts that are currently
installed in your System file to a new temporary file. After
the fonts have been safely copied to the temporary file,
Remove them from the System file. (Note: you will not be
able to remove some sizes of Chicago, Geneva and
Monaco). Then select all the fonts in the temporary file and

Copy them back into your System file. This will add all the
new (FOND) information about the existing fonts to your

System file.

Once this has been done to a System file, you should never
have to repeat this proceedure for that particular System.
You should update all your System files.
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Art Roundup Tools

There are four tools in the Art Roundup tool box: The marquee, lasso, eraser and
grabber hand.:

The Marquee tool

The marquee 1s a way of selecting an area of the image. When this tool is selected, the
cursor changes to a crosshairs shape. Click and drag the mouse, creating a rectangle
with a dashed outline—the marquee. If you should move the cursor outside the section
of your image that shows on the screen, your image will automatically scroll while you
continue to select. This will allow you to select more of the document than will fit in

the window.
| E Selecting with the Marquee:
| v 1. Point and click in upper left corner
L2 2.Drag to lower right and release button

The Lasso tool (the inspiration for Art Roundup’s name!)

The lasso tool is also a selection tool. Use the lasso to draw around an image; selecting
it. After the image has been selected, it will appear to “shimmer”. The lasso differs
from the marquee: Marqueeing selects everything within a rectangular area (including
the white pixels); Lassoing selects only the black pixels within an irregularly shaped
area. Sometimes images are spaced closely together in files; using the marquee can

select part of an adjacent image that you do not want. The lasso comes in very handy
for isolating a single image. |

Selecting with the Lasso:
- 1. Point and click

2. Drag around the image
3. Release mouse button

The lasso will connect itself to the
beginning point, and the selected
image will “shimmer.”
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The Eraser tool

The eraser allows you to “white out” part of an image that yqu.do not want to be
selected with the marquee. Erasing will not affect your original file, as Art
Roundup can only read files, and does not write anything back to them.

Sometimes the eraser/marquee combination can be a good alternative to using the lasso
tool. This is useful in situations where images are spaced so close l&ogethe‘r within a file
that selecting one with the marquee would also leave part of the adjacent image selected
as well. The eraser allows you to remove the adjacent image before selecting. If you
were not blessed with a steady mousing hand—the eraser may be more your style than

the lasso.

The Grabber Hand tool and the ScrollBars

The erabber tool provides a quick way of scrolling around a file. Simply click @ﬂd
draggarnywhere inpthe window that the cursor appears as a grabber hand. The window
will scroll as you drag the grabber hand. Use the gr?bbqr hand when you want to
scroll very quickly in both horizontal and vertical directions at the same time. While
the option key is down, any other tool will change 1nto the grabber tool.

Use the scroll bars for finer adjustments or to restrain the scrolling movement to one
axis. The arrows will scroll one pixel at a time—a very slow scroll. Click in the gray

area of the scrollbar to scroll at a faster speed.

The Zoom boXx

If you are running Art Roundup on a machine equippqd with the lZS_K l_iOM, the Art
Roundup window will have a zoom box in the upper 11 ght corner of its titlebar:

Art RoundUp by Dubl-Click

Clicking in the zoom box will toggle between two different sizes of your window. One

is whatever size the window has been grown to (using the grow box in the lower right
corner of the window). The other size will be full-screen (or on large screen displays

-+ will be full-document; no larger than 576 pixels wide x 720 pixels tall).
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The Art Roundup Menu

When the Art Roundup window is the active window (in front of all other windows),

our menubar will replace the current application's menubar. Don't worry! Our

menubar will go away when the Art Roundup window is no longer active, or when you
Quit Art Roundup.

& Art RoundUp |
About Art RoundUp

& fArt RoundUp
About Art RoundUp

.............................................................

& Art RoundUp
thutﬂrtﬂuundUp

snpenrr bl A AR AR AR A A FRAPEdAAARESEd AR Rd S AdEFEEAENFFFFEAAENFREVENEE AN D

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

fET g1 Cut B H Cut 3 H
LD 331 Copy D Copy 3L
f ipar Clear Clear

lllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll

Open Paint File 380

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

Open Paint File %0 Open Paint File 3¥0

Show Page Show Page Show Page
Hide Tools Hide Tools Hide Tools
inger? Fnisprd Invert

P Bartzantal Fiip Harizoantal
f i Pertigat i Bartiost

AAREFEAAAAANRERESAdAANFFFIRUNENESEF AR RN ENRER R R A ra A A A AR R AAAAAREE 800 MNP RFRMANFRRRRYERF AR AR A AR R R A AN A NS R F AN R RIAAYEFEY

Flip Horizontal
Flip Vertical

lllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll

No selection with Lasso selection with Marquee selection

Some menu options will be dimmed if you have not yet selected anything using either
the Lasso or Marquee tools.

The Menu items:

About Art Roundup. This simply displays an “about” dialog box with information
about this desk accessory. Click the OK button to close the “about” dialog.

Cut and Copy. These allow you to transfer the current selection to the clipboard,
where the image may then be pasted into another document once Art Roundup i1s no
longer the active window. Cut works just like the Copy , except it also does a
subsequent Clear.

Clear. This erases the current selection to white. The original “paint” document file
is not affected—only the onscreen copy of itis. This is a good alternative to the Eraser
tool, when you wish to erase a very large section.
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Open Paint File. This will display a dialog box with a listing of all files that Art
Roundup knows how toread. Select the filename you wish to read, and then click the
open button. Please note that opening a file simply creates a copy qf the file, so any
graphic operations performed in Art Roundup will not affect the original file. After

opening the file, the Art Roundup window will look like this:

& Art RoundUp

------------------------------------------

----------------------------------------------------------------------------------------

......................................................................................................................................................
B o e e i e I AR et i e e e T B e e T e

--------
---------
..............................
...................................................

- =
llllllll
--------

-------------------------------------------------
.........................................................................................................................................................................................................................................
lllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll
.................................................................................................................
...............................

cc<c< WARNING>>>>

The Art Roundup desk accessory itself occupies less than 8K of memory:‘(wpaiused to
be considered a theoretical limit to a desk accessory's size). However, a “paint
document when opened and unpacked occupies around SOK of memory. Art Roundup

has been designed for speed (primarily in scrollin g)——perl?aps at the expense of
memory. Depending upon how much free memory is available at the time, Art

Roundup may not be able to open. Free memory is affected by such 'thir}gs as: the
RAM chip(s) in your Macintosh, Switcher, Servant, the current application(s) running,
other open desk accessories, and the number of document ﬁles currently open. )’Gu
may find that simply by closing another window, and starting Art Roundup again that

there is enough free memory to allow Art Roundup to work.

Page 15



Show Page displays a dialog box (see below) with a reduced size image of the entire
page. The gray rectangle inside the representation of the page indicates the current
position of the window relative to the entire page. You may click inside the gray
rectangle and drag it around the page. Think of this rectangle as a viewer: where ever

you drag it, that is the section of the page that will be visible back in the Art Roundup
window.

Clicking the OK button will close the “Show Page” dialog box. The Art Roundup

window will scroll according to where you positioned the gray rectangle in the “Show
Page” dialog box.
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The gray
rectangle

Hide Tools / Show Tools. This will either hide the toolbox (if it is showing) or will

show to the tools (if they are hidden). Tap the spacebar as a shortcut to selecting this
command from the menu.

Invert will invert the current Marquee selection.
Flip Horizontal will flip the current Marquee selection backwards.

Flip Vertical will flip the current Marquee selection upside down.

Quit will close the Art Roundup desk accessory and restore the original menubar.

You may also quit Art Roundup by clicking once in the Art Roundup window's close
box (in upper left corner of the window's titlebar).
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Using the Pattern Mover desk accessory

Each WetPaint file has a different set of patterns saved with it. Thf: Pattern
Mover desk accessory allows you to transfer single patterns or entire pallettes
between different FullPaint or MacPaint files (not just from WetF_’gm_];——but your
own files too. You can use Pattern Mover in any Macintosh appllcauon that
supports desk accessories (that has an & menu) including FullPaint and MacPaint.

The Pattern Mover desk accessory is contained in a Font/DA Mover file of the same

name, located in the utilities folder on disk “A” of each ﬂp_tfjaiqt volume. Pattern
Mover must be installed using Apple's Font/DA Mover application before 1t can be

——— I —

used (see the using Font/DA Mover section of this manual). After installation,
Pattern Mover will appear in an application's @ (Apple) menu.

Dubl-Click's Pattern Mover vl.0

EREEEEEEEEEEEEEEE

Top
I
BRI L TR Bottom
. il %E@E el @ < Pallette

Use Defaults Clear R8Il All Random

@ Paint files O PAT¥# Resources Mirrors: D4 Horz [ Vert

Loading and Saving Patterns from files

Click on the Open button to load patterns from any paint file into the top pallette.
Clicking on the Save button allows you to select a file in which to save all the
patterns in the bottom pallette. The file you load patterns from does not have to be

the same file you save patterns to.
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About the buttons:

Instructions displays an abbreviated version of these instructions.

Copy All copies the top pallette to the bottom paliette.

Swap Pallettes moves the top pallette to the bottom pallette, and vice-versa.
Use Defaults copies all the System patterns* to the bottom pallette.

Clear All clears every pattern in the entire bottom pallette to white.

All Random button fills the bottom pallette with 38 new random patterns.

About the checkboxes:

The Mirrors come in two flavors: Horz (horizontal) and Vert (vertical). These
govern the symmetry of randomly generated patterns.

About the radio buttons: (note that only one can be selected at a time)

Paint lf‘iles indicates that you wish to read and/or write the patterns to FullPaint /
MacPaint document files. Note that writing patterns to paint files will not affect the
pictures that are also contained within the files.

PATi# Resources indicates that you wish to read and/or write the patterns as
resources. If you do not know what a resource is, you should probably not use this
option, and can skip over this section. Pattern Mover always assumes an ID# 100
type PAT# resource, which happens to be what MacDraw uses. So you can now
change MacDraw's patterns (except while MacDraw is open). If you attempt to
open a file which does not contain an ID# 100 type PAT# resource, Pattern Mover will
just beep. If you save patterns into a file with an existing ID# 100 type PAT#
resource, Pattern Mover will renumber the existing pattern list, and save your new
patterns as ID# 100. Note that once patterns have been saved as a resource, you can
edit them and change their ID numbers using ResEdit (from Apple Computer).

Moving and Editing individual Patterns

Clicking on an individual pattern in the top pallette bestowes on it the honor of being
the current pattern (and draws a box around it). Clicking on an individual pattern in

the bottom pallette (with the paint bucket cursor tool) will replace 1t with whatever
the current pattern is.

* The System patterns are located in the System file. They are a pattern list resource
(resource type PAT#, of resource ID #0).
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Pulling down Copy from the Edit menu, copies the current pattern onto a psuedo
clipboard (this psuedo clipboard does not allow transfer of patterns between Pattern
Mover and other applications). Pulling down Paste replaces the current pattern with
the pattern on the psuedo clipboard. Clear sets the current pattern to white. Cut does

a Copy and then a Clear.

Double-clicking any single pattern (top or bottom) will bring up a Fatbits-style editing
window (shown below). You may also hold down the option key and click any single
pattern to edit it (without first selecting a new current pattern, or replacing the bottom

pallette pattern).

While editing, you can perform
other graphic operations on the
pattern being edited by clicking the
appropriate buttons. Invertit,
Rotate it, and Flip it vertically or
horizontally by clicking the
appropriate buttons. Revert
restores the pattern to what it was
before you started editing. Undo
restores the pattern to what the
pattern looked like before your last
operation on it (it restores only
once—you cannot undo the Undo).

If you move your cursor outside this fatbits-style dialog box, your cursor will h
change from an arrow to a 8 x 8 pixel box. Click outside the Edit Pattern
dialog box, you can “pick up” whatever image is under the box-shaped cursor
and turn it into a pattern. O

Using Pattern Mover while working in FullPaintrm or MacPaintm

To change the current file's patterns in FullPaint, first close the file, then pull down
Pattern Mover and save the new patterns {0 your file. After saving the patterns in
the closed file, put Pattern Mover away, then re-open the file using FullPaint.

In MacPaint, you can switch patterns in the file you're currently working in without
first closing it! Here's how: Just before you pull-down Pattern Mover from the *

menu, pull-down Save from the File menu. After you save the new patterns to your
paint file and close Pattern Mover, pull-down Revert from the File menu. The new

.

patterns will be read in from disk, along with your picture—which of course never
changed between the Save and Revert commands!
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1B Volume 1, Disk
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Be Mine

Desk Stuff #1
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Let's Party!
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Tools of the Trade
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Xmas Cheer
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Xmas Season
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B Vol Disk
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For Power Users
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Logo Shapes #1
Logo Shapes #2
Logo Shapes #3
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Seasons
Semaphores
Stars

The Old West
Trees

Weather
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1C Volume 1. Disk

Am. Sportsman
Animal Fun #1
Animal Fun #2
Birds #1

Birds #2
Computers #1
Computers #2
Computers #3
Critters
Dinosaurs

Don't Bug Me
Jumpers

Love at 1st Byte
Prints Charming
Safari #1

Safari #2

2C Volume 2, Disk G

Desktop Publishing?
Eat, Drink...

Fun Pix

Grin & Bear it
K-9 Corp

Kennel Club
Label Ideas
Money, Money...
Plate Frames
Plate Letters

Spin your own!
T-Shirt Shop
Time Machine #1
Time Machine #2
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1B Howdy Pard
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volumes of clip-art and fonts called Mac the
Knife. A year later after leaming 68000
assembly language, he teamed up with Austin
Durbin to form Dubl-Click Software and produce
their first product, The Calculator Construction
Set. Chiff also helped produce Dubl-Click's first
two World Class Fonts! volumes with co-authors
Mary Martinez and Steve McClure. When Doug
Robertson's international fame and fortune do
arrive, Cliff has graciously agreed to journey
forth from trendy L.A. and keep Doug
Robertson, Pee Wee Herman and David

Letterman company on the Late Night show.
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PictureBasew format

WetPaint volumes are now available in
PictureBase format. Ordering
instructions appear on your WerPaint
warranty card.

If you don't yet know about PictureBase,
now might be a good time to learn about
this unique art storage and retrieval
system—particularly since you now have
several disks of pictures to browse
through. PictureBase can help you
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quickly locate and retrieve specific 1mages—because each image is indexed by title and
keyword(s), when placed in a PictureBase library file. For instance, simply type in
“weather” and all images using that keyword are displayed.

PictureBase stores both bitmapped and object-oriented images and supports automatic
scaling by 50%, 25% and 12.5%. System requirements: 512K or more of memory,
external floppy or hard disk drive recommended. Suggested retail: $69.95 from:
Symmetry Corporation, 761 E. University Drive, Mesa, AZ 85203. Order line:

1(800) 624-2485 (in Arizona 6(02-844-2199).

@ FullPaint format

As you have probably noticed, WetPaint
is distributed in FullPaint format files. If
you were wondering what FullPaint was,
don't yet own MacPaint, or are more than
just a casual MacPaint user, you really
owe it to yourself to check out the second
generation of “paint” programs—of
which FullPaint is one. FullPaint 100Ks,
works and “feels’ like MacPaint. If
you've already learned how all of
MacPaint’s tools operate—including the
many ‘‘command-shift-option-double-
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click” shortcuts, you'll be happy that they all work the same way in FullPaint. As the
name implies, FullPaint lets you edit a window the size of the Mac screen (342 x 512
pixels). Tools and patterns float on top of your document, but can be hidden at any
time. With 512K of RAM (at least 512K is required), two document files can be open
at the same time; four with 1024K. Suggested retail is $99.95 from: Ann Arbor
Softworks, 2393 Teller Road, Suite 106, Newbury Park, CA 91320. (805) 375-1467.



Suggested Reading

Becoming a Mac Artist by Vahé Guzelimian, Compute! Books. A good
tips/techniques guide for the novice to intermediate MacPainter.

Desktop Publishing by Kevin Rardin, Plume/Waite. As the name implies, this goes
way beyond just “paint” programs, covering layout techniques.

Mac Graphics by Tony Fabri & Gregory W. Thorne, Tab Books. A “good general
overview” type of book.

MacPaint Drafting Design by Susan Schmieman, Brady Books'. Although focusing
on using MacPaint as an alternative to MacDraw for drafting, this book touphes on
many basic MacPainting techniques. A good book for the absolute MacPaint novice!

Zen and the Art of the Macintosh by Michael Green, Running Press. This 1s not a
how-to book, with tips and techniques. It is a collection of Maciptosh generated art
work. Consider it inspiration; you'll get ideas on layout and design.

Related Graphic Software

FullPaint /| FullWrite Professional. See description of FullPaint on previous
page. FullWrite is a word processor/page layout package; includes MacDraw style
graphics tools. Ann Arbor Softworks, 2393 Teller Road, Suite 106, Newbury Park,
CA 91320. (805) 375-1467.

MacBillBoard. A good single-document alternative to MacPaint with lots of new
features. Best feature: print multiple copies of the same paint document (a must on the

LaserWriter!). CE Software, 801 73rd St., Des Moines, IA 50312. (515) 224-1995.

MacPaint /| MacDraw. The originals. MacPaint is still a masterpiece. Apple
Computer, Inc., 20525 Mariani Avenue, Cupertino, CA 95014. (403) 996-1010.

PageMaker. A reliable page layout program (we used it to create this manual).
Aldus Corporation, 411 First Ave. S., Suite 200, Seattle, WA 93104.

PictureBase. See description on previous page. Symmetry Corp, 761 East
University Drive, Mesa, AZ 85203. 1(800) 624-2485. In Arizona (602) 844-2199.

SuperPaint. Create/edit MacPaint and MacDraw style pictures within the same
program. Includes lots of new paint tools/tricks. Our favorite featurq : draw cuclgs
from center point. Silicon Beach Software, 9580 Black Mtn. Rd., Suite E, San Diego,
CA 92126. (619) 695-6956.

The Legal Stuff

License Agreement
from Dubl-Click Software, Inc.

The price of WetPaint licenses the product for
use on one Macintosh. You may use print-
outs of the artwork contained in WetPaint for
anything you wish, so long as you do not
resell the print-outs as clip-art. If you use
WetPaint images as logos (without alteration)
be aware that you may not be able to protect
them with a copyright (consult your own legal
counsel on this point). You may make copies
of the disks for your own archival purposes.
You may not make copies of the disks for
others for any purpose including resale.

If you discover physical defects in the media
on which this software 1s distributed, or in the
manuals distributed with the software, Dubl-
Click will replace the media or manuals at no
charge to you, provided you return them along

with a self- addressed, stamped return mailer
to Dubl-Click Software, Inc.

The Fine Print from our Legal Eagles

EVEN THOUGH THE SOFTWARE HAS BEEN TESTED,

AND THE DOCUMENTATION REVIEWED, DUBL-CLiICK

MAKES NO WARRANTY OR REPRESENTATION,
EITHER EXPRESS OR IMPLIED, WITH RESPECT TO
THIS SOFTWARE, ITS QUALITY, PERFORMANCE,
MERCHANTABILITY, OR FITNESS FOR A
PARTICULAR PURPOSE. AS A RESULT, THIS
SOFTWARE IS PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND. THE ENTIRE RISK AS TO
THE RESULTS AND PERFORMANCE OF THE
SOFTWARE IS ASSUMED BY YOU. SHOULD TIIE
SOFTWARE PROVE DEFFECTIVE, YOU ASSUME THE
ENTIRE COST OF ALL NECESSARY SERVICING,
REPAIR, OR CORRECTION. YOU RELY ON THE
SOFTWARE AND RESULTS SOLEY AT YOUR OWN

RISK. DUBL-CLiCK SOFTWARE SHALL NOT BE HELD
LIABLE FOR ANY DIRECT, INDIRECT,

CONSEQUENTIAL, OR INCIDENTAL DAMAGES
ARISING OUT OF THE USE, THE RESULTS OF, OR
INABILITY TO USE THE PRODUCT EVEN IF DUBL.-
CLiCK SOFTWARE HAS BEEN ADVISED OF TIIE
POSSIBILITY OF SUCH DAMAGES OR CLAIM. AlLL
IMPLIED WARRANTIES ON THE MEDIA AND
MANUAL, INCLUDING IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, ARE LIMITED IN DURATION
TO NINETY (90) DAYS FROM THE DATE OF THE
ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

Font/DA Mover License

This language has been required by
Apple Computer, Inc.

Apple Computer, Inc. makes no warranties,
either express or implied, regarding the
enclosed computer software package, its
merchantability or its fitness for any particular
purpose. The exclusion of implied warranties
1S not permitted by some states. The above
exclusion may not apply to you. This
warranty provides you with specific legal
rights. There may be other rights that you may
have which vary from state to state.

The Font/Desk Acessory Mover is a
copyrighted program of Apple Computer, Inc.
licensed to Dubl-Click Software to distribute
for use in combination with the WetPaint
Classic Clip-Art Volumes. This Apple
software shall not be copied onto another
diskette (except for archive purposes) or into
memory unless as part of the installation of
WetPaint fonts and/or desk accessories. When
WetPaint fonts and/or desk accessories have
been nstalled, the Apple software shall not be
used by any other program.




